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① My Day Shows upcoming events from your Outlook calendar.

② Accounts Pane Click (􀌃) to show/hide the account pane.

③ Profiles Switch between your personal profile and work profile or you can show all (􀆪) profiles.

④ Toolbar Quickly access commands. From left to right: Create new mail, Delete, Archive, Report, Move, Flag, Mark 
Unread, Sync, Block and More Tools (�).

⑤ Search, What’s New & Notifications Start typing in the Search field to instantly find what you’re looking for. Click 
What’s New ( ) to view the latest features for Outlook. Click Notifications (� ) to view recent notifications. 

⑥ Show/Hide Task Pane (     ) Show or hide a mini calendar with your agenda for the day.

⑦ View Switcher Click to switch views. Outlook has six different apps. Mail, Calendar, People, Favorites, To Do and 
Notes (Notes is accessible in More apps [�], when selected, it will launch your default web browser). Toolbar 
commands will update to match the view you choose. 

⑧ Account Navigation Pane Click to navigate to different accounts and folders in Mail. Click Expand (􀆊) to the left of 
the folder to view the contents.

⑨ Message List Select the Inbox or folders to see a list of the items within. Your list could be customized in content 
and how the list is arranged. Mail Views are custom views of information. 

⑩ Reading Pane Displays text of the selected email from the message list. The Reading Pane can be set to the right, 
below or hidden.

The Outlook Main Window: Mail View
①

② ⑤

⑥

⑧

⑦

③

⑨ ⑩

④
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Focused/Other Inbox
Focused Inbox separates your inbox into two tabs, Focused and Other. Your more important emails are in the Focused inbox 
while the rest remain easily accessible, but out of the way, in the Other inbox. Focused Inbox requires Microsoft 365 in order 
for it to appear in Microsoft Outlook for Mac. You’ll be informed about email flowing to Other, and you can switch between 
tabs any time to take a quick look.

The Focused and Other tabs will appear at the top of your inbox. NOTE: You can set the badge count, the count of unread 
mail, to include only the messages in the Focused list. Go to Outlook > Settings > Notifications and Sounds > Badge count. 
See Figure below to see the choices. 

From the Focused Inbox, 
right-click the message 
and choose Move to 
Other or Always Move 
to Other

From Other, right-
click the message 
and choose Move to 
Focused or Always 
Move to Focused

Change how your messages get organized
1. From your Inbox, select Focused, and then select the message you want to move.

2. Click on the Message menu or right-click to access the contextual menu and select “Move to Other” if you want only the 
selected message moved. Click on the Message menu and select “Always Move to Other” if you want all future messages 
from the sender to be delivered to the Other inbox.

3. To move a Message from Other to Focused, select Other and then select the message you want to move to Focus. 

4. Click on the Message menu or right-click to access the contextual menu and select “Move to Focused” if you want only 
the selected message moved. Click on the Message menu and select “Always Move to Focused” if you want all future 
messages from the sender to be delivered to the Focused Inbox.

Turn off Focused Inbox
1. Click on the View menu.

2. Deselect Turn on Focused Inbox from the menu.

3. Confirm Focused and Other Inboxes are united in one Inbox.
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Toolbar
The toolbar gives you quick access to frequent commands such as creating a new piece of mail to be sent or to delete 
mail from your inbox. You may customize your toolbar by adding or removing tools. 

To customize your toolbar:
1. On the toolbar, click Options (�).
2. Select Customize Toolbar. 
3. To Add tools, Drag and drop into the Toolbar. To remove a tool, right-click on the item and select Remove. You 

may also add or remove Add-ins.
4. Click Done. 

Customize the way your Toolbar looks
• Show Labels Always - The icon and description will always appear on your toolbar. When the amount of tools 

exceed the length of the toolbar, the tools will continue in the Option menu (�).

• Show Labels as Space Permits - The icon and description will appear on your toolbar until it exceeds the length 
of the toolbar. For example, if you resize Outlook to make it smaller, the toolbar will go from icons and description 
to just icons. 

• Hide Labels Always - Icons will appear on the toolbar with no description. 

Revert back to the default view
1. On the toolbar, click Options (�).
2. Select Customize Toolbar. 
3. Click Reset Toolbar.
4. Click Done. 
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List of tools for the Toolbar

Delete Moves the mail to the Trash. 

Archive If available on your email account, archive allows you to move an item from your Inbox to an archive folder. An 
archived item (or items) remains accessible, but doesn’t clutter your Inbox

Move Moves the email message to another folder.

Flag Flag the selected email for follow up. 

Pin/Unpin This will pin/unpin a selected message.

Read/Unread Mark an email as Read or Unread. 

Reply Reply to just the sender.

Reply All Reply to all on the message.

Forward Forward the email to a recipient or recipients. 

Sync Manually perform a sync to your account.

Categorize Assign a category to a selected message or messages.

Forward as Attachment Forward a message in your Inbox as an attachment.

Undo Reverses the last command you have done in Microsoft Outlook.

Redo Reverses the last Undo you have done in Microsoft Outlook.

Print Print out the selected message.

Mark All as Read Mark all unread emails as Read in the inbox.

Report While viewing a message in Outlook, you can choose to report a message as Junk, Phishing or Not Junk. 
• When you choose Phishing, the message is moved to the Deleted Items folder and marked as phishing
• When you choose Junk, the message is moved to the Junk Email folder
• When you select either of these options, the message is reported to Microsoft. 

Block Block the sender. Outlook adds the sender’s email address to the blocked senders list 

Ignore Conversation Ignore Conversation removes all messages related to the conversation that you select and moves 
future messages in the conversation directly to your Deleted Items folder. To stop ignoring a conversation, go to the 
Deleted folder and select the conversation that you want to recover, or any message within that conversation. Select 
Ignore > Stop Ignoring Conversation.

Create a Meeting Creates a meeting with the contents of the email in the body.

Create an Appointment Creates an appointment with the contents of the email in the body.

Snooze Allows you to snooze a message from appearing in your Inbox for a period of time. 

Rules Edit or Create Rules, apply a rule to an email or selected emails. 

Retention Assign a retention policy that was set by your administrator to a message. Retention policies control how long 
your messages will be saved. 
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Message List Pane

Indicates High Priority

Indicates the 
email is in a 
Category

A paper clip indicates a Message has 
an Attachment

The curved arrow pointing to 
the left Indicates that you have 
replied to the message

Expands or 
collapses 
conversations 

Unread 
messages in 
your Message 
List have a blue 
dot to the left 
with the subject 
and time 
emphasized in 
blue

When you click 
reply, a Draft is 
ready for you 
to compose an 
email

Hover over your message to 
show Quick Actions. You may do 
one of the following: 
• Flag your message
• Pin a message
• Move it to the Trash

A curved arrow pointing to the right indicates a 
message has been forwarded

Icons in the Message List

Shows there is a 
new message in the 
conversation

Pin Messages
When you pin a message, it moves the message to the top of your Inbox, so it will be easier to find. To pin a message, 
in the message list, hover over the message you want to pin, and then click the Pin (􀎧) that appear to the right of the 
message title.

Pinned message
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The Message List displays the messages for whichever folder you have chosen in the Navigation Pane. The message 
list allows you to see who the email came from, the subject of the email, when it came in and gives you a preview of the 
Message. When you launch Microsoft Outlook for Mac, you will always begin where you left off last. 

Sorting the Message list
Click Message List Options (􀜓) to filter your messages or sort them by a different format. For example, you may want to just 
filter your unread emails without being distracted by your read emails. You may also want to sort them by who the email is 
from.  

Click Message List 
options (􀜓) to filter or 
sort your message list

Reading Settings
You may customize the Message List by going to the Reading settings (Outlook > Settings > Reading). You can turn off 
Focused Inbox or turn off Conversations from the Settings. You can also change how you swipe a message or add more 
features to Quick Actions. 
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Email Message
Double-click on an email message from the Message List will open the email in a separate window. This may allow you to 
reference other email messages in the Message List.

① Title of email Shows you the subject of the email and where it’s located on your account. 

② Toolbar Allows you to execute commands such as Delete, Archive, Report, Move, Flag or Mark Unread. 

③ Email details Shows you who sent the email as well as who is copied on it. It also shows you the time and date on 
when the email was received.

④ Quick Action Tools Quickly click one of the tools to respond. From left to right: React (emojis), Reply to sender, Reply 
All and Forward.  

⑤ Options (�) Click for more actions, use one of your Add-ins or customize the toolbar. 

⑥ Email Message Shows you the content of the email. It can include conversations in the message. It can have media 
such as pictures embedded in the Message. 

①

② ⑤

③
④

Categorize
You can organize your messages by assigning them to categories. Since categories are color coded, it can make items 
easier to find. To select a category for a message, click on the Message > Categorize and select a category. 

⑥
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Flagged Email Messages
Flags make it easier to find and track email messages. You can flag messages for yourself, as visual reminders to take action 
later. You can also flag messages that you send to other people, to direct their attention or track their responses.

Review flagged messages
In the Inbox
Click Message List Options (􀜓) and select Flag > Flagged.

Smart Folder In Saved Searches
Messages that you flag appear, automatically in a Smart folder in Outlook called Flagged Mails. In the Accounts Pane, 
scroll towards the bottom. Expand Saved Searches and select Flagged Mails. You will see all the emails that have been 
flagged, even the ones that are not in the Inbox.

How to flag an email
In the Message List
• Hover over an email in the Message List and click on the flag on the right.

• Select the mail In the Message list and go to the Toolbar. Click Flag and select a time frame to create a reminder for 
yourself to follow up with an email. If you choose No Date as a time frame, no reminder will be created. 

In an Open Email
When you have a piece of mail open as a separate window, click Options (�) and select Flag. Select a time frame to create a 
reminder for yourself to follow up with an email. If you choose No Date as a time frame, no reminder will be created.

Flagged Item

Hover or select the email and 
click on the flag
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Save as Draft 
If you would prefer to send the email at another time, the email can be saved as a draft. When you create a new email, 
the draft is automatically saved in the drafts folder waiting to be sent. 

Priority
When you want people to know your email needs urgent attention, set the message as High (!). If the message is just an 
FYI, or if you’re sending mail to colleagues about a non-work related topic, you can set the message as Low (↓). 

Attachments
There are 3 ways to add attachments to a message:
1. Click Attach File in the Message toolbar and then navigate to the file. 
2. Drag and drop the file from your Desktop or from a folder to the email message. 
3. Click on the Draft menu and choose Attachments > Browse this Mac. Navigate to the file and click Choose.  

Note: If you choose to attach a folder, in the confirmation dialog box, choose Compress. This will auto-generate a zip file 
as an attachment. 

New Mail Message
This section covers creating new email and using it’s options such as attaching a file or setting a message priority.

Create a New Email 
1. On the Toolbar, click New Mail.
2. A untitled email message appears to the right.
3. Enter the name of the contact or an email address. Possible matches will appear as you type. Outlook will search from 

Contacts and Recent Addresses, then from the Directory.
4. Select the email address and it will be entered in the field. 
5. Enter a subject for your email.
6. You can now add content to your E-mail message.

1

3

Draft 

auto-saved

Set a 
priority 
for your 
message
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More Tools in the Format Bar
In addition to the standard formatting tools such as changing font size, color or italicize a phrase or word, Outlook for Mac 
offers other formatting tools such: 

① Highlight use to highlight selected words. 
② Superscript Format a character(s) to a superscript (a character, such as a number or letter, that is set slightly above the 

normal line of type.) 
③ Subscript Format a character(s) to a subscript (a character, such as a number or letter, that is set slightly below the normal 

line of type.) 
④ Bullet Point List Formats selected text as bullet point listing. 
⑤ Number List Formats selected text as number listing.
⑥ Paragraph Alignment 

• Align paragraph, flush left.
• Align paragraph, flush center.
• Align paragraph, flush right.

⑦ Decrease Indent Moves the sentence to the left.
⑧ Indent Indents a sentence to the right.
⑨ Dictation Click to dictate your message. 
⑩ Attach Photo Attach a photo from your Photos App or from your Mac.
⑪ Hyperlink Create a hyperlink on selected word(s).
⑫ Tables Insert a table in your Message.
⑬ Clear All Formatting Clear all formatting from selected content.
⑭ Copy Formatting Insert a table in your Message.
⑮ Paste Options: 

• Keep Source Formatting
• Match Destination Formatting
• Paste as Picture
• Keep Text Only

⑯ Undo 
⑰ Redo
⑱ Show/Hide Invisibles View/hide visual indications of spaces, tabs, and carriage returns

@Mentions
If you’d like to get someone’s attention in an email message or a meeting invite, use @mentions in the email message or a 
meeting invite. Just enter ampersand (@) followed by the name, their name will be highlighted in the message or invite and 
Outlook will automatically add them to the “To” line of the email or meeting invite. They will see the @ symbol next to the 
message in their Inbox. 

①

⑫②

⑤ ⑬ ⑮ ⑰

⑥

⑦③

⑧④ ⑭ ⑯ ⑱

⑨

⑩

⑪
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Spell Check & Grammar
Check spelling and grammar automatically as you type
By default, Outlook checks for spelling errors as you type. Outlook uses a dashed red underline to indicate possible 
spelling errors and a double blue line to indicate possible grammatical errors.

1. When you see a word with a dashed underline, Control-click the word or phrase and choose one of the options.

2. On the shortcut menu, do one of the following:
• Select one of the guesses at the top of the shortcut menu.
• Select Ignore All or Ignore to leave the word as is.
• Select Add to Dictionary.

Microsoft Editor
Microsoft Editor helps users improve their grammar when using Office apps such as Word and Outlook. It offers spelling, 
grammar, and writing style. The extension is on by default in Outlook. To access Editor, go to Edit > Spelling and 
Grammar and select Editor. It will go through the selected paragraphs and may make some suggestions to you. 

Resetting spelling and grammar checking
To reset the spelling/grammar checker so Outlook can recheck words and grammar that you have chosen to ignore, go 
to Edit > Spelling and Grammar and choose Reset Ignored Words and Grammar. Click Yes to confirm. 

Spelling Grammar
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Tips
• You can use Microsoft Word for Mac to format text and add pictures and links. After you finish formatting your signature, 

copy your new signature and paste the signature into the signature pane of Outlook.

• You can create different signatures for your new messages and replies/forwards. You can also create default signatures 
for all your email accounts in Outlook.

Manually selecting the Signature
When you create an email and the default Signature was not the one you intended to use, you can manually select another 
one by clicking the Signature button and choose the appropriate one. 

Signatures
You can have custom Signatures to place automatically at the end of messages you create. 

1. Go to the Outlook Menu and select Settings.
2. Click on Signatures.

3. Under Signature name, Click Add (+).

4. An Untitled window will appear. . 

5. Enter your information that you want in your signature.

6. Click Save. 

7. Under Choose default signature, select the account you want to use as your default signature for New Messages and for 
Replies/forwards.

1

2

7

3

5

6

4
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Rules
The goal of organizing your Outlook is to reduce the amount of unnecessary “noise” in your Inbox and to make the 
most important items reach the top. Rules help this process by moving messages into folders based on criteria that 
you set. Rules filter the messages coming into your Inbox for must-read items or read later.

Create a Rule based on the sender’s name or a contact group
You can create a rule that moves all messages from [name], to a folder called “Mail from [name].” If you are receiving 
mail from a distribution list, you can automatically move it to a specific folder as well.

1. Create a new folder in Outlook.
2. In the message list, click an email message with the sender or recipient that you want to create a rule for.
3. Go to the Message menu and select Rules. Select a rule suggestion. I.E. “ Move Message from....” (Fig. A). 
4. In the folder search field, start typing the name of the folder that you want to move messages to (Fig. B). 
5. When the folder you want appears, click the folder name to select it.
6. Click Save. 

Fig. A

Fig. B
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Editing a Rule
When you create a rule from an existing message, the sender and recipient are automatically pre-populated in the rules 
instructions. What happens when you want to add more details to the rule, such as adding another recipient or if it’s a 
particular subject? To edit an existing rule:

1. Go to the Message menu and select Rules > Edit Rules.
2. Click Edit (􀈊).	                
3. You will see what the rule is set to do.

4. Click Add (+). A new criteria is added to the next line.
5. Click and choose an action. For this example, we are selecting Sent To. 
6. Fill in the field with the name of the recipient.
7. Click OK.

8. The rule has any email Joan sends to Craig, will go the Joan folder under rgoon@hcsonline.com’s account. The rule 
will apply to any emails addressed to or CC’d (carbon copied) to Craig. 

Create rules for different accounts
You can create different rules for different types of account such as IMAP, POP or Exchange. Make sure you select the 
correct type before creating the rule. 

Tips
• If you have a Microsoft Exchange account managed by Microsoft Exchange Server 2010 or later, the rule is automatically 

saved on the server.

• If you create multiple rules, Outlook runs the rules in the order in which they are listed in the Rules window.

5 6

7
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Search in Microsoft Outlook for Mac
From the search bar, you can do a quick search of the current folder. You can also search to find text within a specific 
item. When you use search from your Inbox or folder, the results will include messages, contacts, and files.

Do a basic search in the current folder
You can use the search bar at the top to search in the current folder or view.
1. Click on the menu and select Current Folder.
2. Enter your search word or words in the search box. Outlook displays the results underneath in Search Results. 
3. After You have finished your search, exit (X) the search bar.

Search Filters
What happens when a word or a phrase is not enough? Click Filters (􀜓) to show more options for your search. Enter more 
search variables and see how it changes the results. 

Save Search
When you click on Save Search (     ), an untitled folder will be created in Smart Folders. Enter a name for the smart folder 
and anything meeting the criteria of the search will go to the smart folder.  

1

2

Search results

Click Save 
Search to 
create a 
smart folder 

Click 
Advanced 
to show 
more search 
options



Microsoft Outlook for Mac User Guide

19

Advanced Query Search
Use Advanced Query Search (AQS) to refine your search results. In the search box, type an AQS keyword from the table 
below, followed by a colon and what you want to search for 

Search Tips
• Keyword searches are not case sensitive. 

For example, cat and CAT return the same results

• When searching on a property:value expression, don’t put a space after the colon. If there is a space, your intended value 
will just be full-text searched.  
For example, to: jappleseed searches for “jappleseed” as a keyword, rather than for messages that were sent to 
jappleseed. To search for messages sent to jappleseed, enter to:jappleseed.

• A space between two keywords or two property:value expressions is the same as using AND.  
For example, from:”John Appleseed”subject:reorganization returns all messages sent by John Appleseed that contain the 
word reorganization in the subject line.

• When searching a recipient property, such as To, From, Cc, or Recipients, you can use an SMTP address, alias, or display 
name to denote a recipient.  
For example, you can use jappleseed@hcsonline.com, John Appleseed, or “jappleseed”.

• You can use only suffix wildcard searches—for example, cat* or set*. Prefix wildcard searches (*cat) or substring wildcard 
searches (*cat*) aren’t supported.

• When searching a property, use double quotation marks (“ “) if the search value consists of multiple words.  
For example, subject:budget Q1 returns messages that contain budget in the subject line and Q1 anywhere in the 
message or in any of the message properties. Using subject:”budget Q1” returns all messages that contain budget Q1 
anywhere in the subject line.

• To exclude content marked with a certain property value from your search results, place a minus sign (-) before the name of 
the property.  
For example, -from:”John Appleseed” will exclude any messages sent by John Appleseed.

Keyword Description Example

From Searches the From field. From:John Appleseed

To Searches the To field. To:John Appleseed

Cc Searches the Cc field. Cc:John Appleseed

Bcc Searches the Bcc field. Bcc:John Appleseed

Participants Searches the To, Cc, and Bcc fields. Participants:John Appleseed

Subject Searches the subject. Subject:report

Body or Content Searches the message body. Body:report

Received Searches for the date received. You can use the same search terms 
as for Sent.

Received:01/01/2017

Category Searches the Category field. Category:reports

HasAttachment:no A search for HasAttachment:no returns only emails without 
attachments.

report HasAttachment:no

IsFlagged:yes A search for IsFlagged:yes returns only emails that are flagged. report IsFlagged:yes

IsFlagged:no A search for IsFlagged:no returns only emails that are not flagged. report IsFlagged:no

Sent Searches the date sent. You can search for a specific date or a 
range of dates separated by two dots (..). You can also search for 
relative dates: today, tomorrow, yesterday, this week, next month, 
last week, past month. You can search for the day of the week or 
month of the year.

Sent:01/01/2024

HasAttachment:yes A search for HasAttachment:yes returns only emails with 
attachments.

report HasAttachment:yes
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Profiles
If you use Outlook for Mac for your personal life and for work, you can set up Outlook to handle these different capacities 
by using profiles. A profile is a workspace that stores a set of email messages, contacts, tasks, calendars, account settings, 
Scrapbook clips, and more.

Create a Profile 
1. Go to the Outlook Menu and select Settings.
2. Click Profiles.

3. Click Add (+).

4. Enter a name for the profile. I.E. Work. 

5. Select an icon and color.

6. Click Create. 

7. Select the accounts that you want to associate with the profile.

1

4

5

6

2
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8. Repeat steps 1- 7 to create a profile for Personal.

9. Confirm you have two Profiles created. Close Settings. 

10. On the top left, click on a profile to view the selected mail accounts. 

Click on a 
profile to 
view the 
accounts 
associated 
with the 
profile

Connect a Profile to a macOS Focus Filters

1. Go to System Settings.
2. Click on Focus.
3. Select a Focus filter.
4. Under Focus Filters click Add Filter (Fig. A). 
5. Select Microsoft Outlook. 
6. Click Choose and select the desired Profile (Fig. B). 
7. Click Add. 
8. Close System Settings.

Fig. A

Fig. B
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Automatic Replies
You can send automatic replies from Outlook for Mac whenever you want to let people who send you email know that you 
won’t be responding to their messages right away. You can specify an end date so that the replies will stop automatically 
when you return, or you can manually turn off automatic replies.

1. Click the Tools menu.
2. Select Automatic Replies.

3

5A

7
6

9

5B

10

8

4

3. Choose a Microsoft 365 account. 

4. Select the checkbox for Send automatic replies for account “<account name>”.

5. Enter your auto-reply.
A. The top field is for senders within your organization.
B. The bottom field is for senders outside your organization.

6. Select the checkbox for Send replies only during this time period. 

7. Set the date and time on when to start the auto-replies

8. Set the date and time on when to end the auto-replies. 

9. Select the checkbox for Send replies outside my organization. 
• Send only to my contacts - Anybody in your contacts who reached out to you through email will only receive your 

automatic replies.
• Send to all external senders - Anybody who sends an email to you will receive your automatic replies.

10. Click OK.
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Email Templates
Email templates are pre-written messages that you can use to quickly compose and send emails without typing the same 
content repeatedly. You can create email templates for different purposes, such as invitations, confirmations, follow-ups, 
feedback requests, newsletters, and more. Email templates can help you save time, improve consistency, and avoid errors in 
your email communication.

1. Click on the New Message.
2. Compose your email message as you normally would, adding the subject, recipients, body, attachments, signature.
3. When you are done, click File menu, select Save as Template.
4. Select an existing folder or create a new folder for your Templates.
5. Give your template a name and click Save.

How to use email templates in the new Microsoft Outlook for Mac

1. Open Microsoft Outlook for Mac and click on the File menu, select New, Mail from Template.

2. Select the template you want to use and click on the Open button.

3. A new message window will open with the template content. You can edit the template as needed, adding, or changing 
the subject, recipients, body, and attachments.

4. When you are ready, click on the Send button in the toolbar.

Updating or changing content when using email templates in the new Microsoft Outlook for Mac

1. Open Microsoft Outlook for Mac and click on the File menu, select New, Mail from Template.

2. Select the template you want to use and click on the Open button.

3. Edit the content of the email for your template.

4. When you are finished editing, click File menu, select Save as Template.

5. Select your template folder.

6. If you are changing an existing template, click Save. If you are creating a new template from an existing template, click 
Save as and give your template a new name. Click Save.



24

Categories
Categories can help you organize items such as your email messages and calendar appointments. You can apply multiple 
categories to the same item.

Create a Category 

1. Go to the Outlook Menu and select Settings.

2. Click Categories.

3. Select an account.

4. Click Add (+).

5. Enter a name for the category. 

6. Select a color.

7. Click Create.

Assign a Category to an object

1. Select one of the many objects such as an email, a 
contact or an event in your calendar. 

2. Assign a category by:

• Right-click or Control-click on the object and 
select a category. (Fig. A)

• From the menu (Email: Message Menu, Calendar: 
Event menu, People: Contact Menu), select 
Categorize and assign a category. (Fig. B)

Tip
Send one email to all the contacts in a category 

1. Click on People.
2. In the Accounts listing, expand Categories.
3. Click on the Category you want to send to.
4. Click on a contact in this category.
5. Select all with Command A or go to the Edit menu > Select All.
6. Click on the Email button in the Toolbar. 
7. You now have an email addressed to all the contacts.  
8. To BCC instead of using To, select all the contacts, and drag them into BCC. 

Fig. A Fig. B

1

2

3

4

6
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Junk Mail Protection
You can adjust your junk email settings to automatically allow messages from specific domains or block messages from 
specific email addresses or domains.

1. Go to the Outlook Menu and choose Settings.
2. Click Junk. 
3. Select an account.
4. Click Add (+)
5. Enter the email address or the domain name.
6. Close the Settings window. 

Outlook Add-ins
Add-ins brings apps, such as Salesforce, Slack, Zoom, or DocuSign, right inside Outlook for Mac. You can accomplish tasks 
quickly without needing to switch back and forth between email and other apps. Add-ins are a great way to increase usage 
of your apps by making them accessible directly within Outlook. 
NOTE: You will need a Microsoft account. If your organization is using Microsoft 365, your email address is your Microsoft 
Account. 

Install Add-ins
1. On the Toolbar, click Options (�) 
2. Select Get Add-ins (     ). (Fig. A)

3. Browse through the catalog or 
search for the Add-in. (Fig. B)

4. Click Add. (Fig. C)

5. Confirm the Add-in appears in the 
menu. Optionally, You may add the 
add-in into the toolbar.

Fig. A

Fig. B

Fig. C

NOTES: 

• Add-ins may need to be configured with an Account. I.E. The Add-in for Slack will require for you to log in with your 
credentials to access the channels.

• When an Add-in is opened, it will appear as a tab next to My Day. 
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Calendar
Outlook’s Calendar can be customized to work the way you do. Call up the Calendar pane by either clicking on the 
Calendar button, or pressing Command (⌘)- 2. A calendar is associated with each mail account. You can have shared 
calendars. The default view is the calendar week, but daily, workweek and monthly views are also available in the 
Ribbon also.

① New Event Allows you to create an Appointment or Meeting in your Calendar.

② Calendar Navigation Quickly access different months from the past through the future.

③ Calendar Accounts Too many events crowding your view? Easily select which Calendar you want to see at any one 
time or choose to view them all at the same time. 

④ Today Click this to see what is on Today’s agenda in whatever view you are in. 

⑤ Previous/Next View Whichever view you are in you can click Previous (􀆉) to see earlier events or Next (􀆊) to view 
future events. I.E. while in Week view, click Previous (􀆉) to see the previous week.

⑥ Weather Forecast Shows you the forecast of the weather for your location for the day. Click to see the details of the 
weather. 

⑦ Filters Filter your events by:
• All
• Appointments

⑧ Calendar Views Select a view for your calendar. You can view the Calendar by Day, Three Day, Work Week, Week or 
Month.

⑨ Show/Hide Task Pane (     ) Show or hides a mini calendar with your agenda for the day.

①

②

⑤ ⑥ ⑦ ⑧

③

⑨

④

• Meetings
• Categories

• Show As
• Recurrence

• Privacy
• Hide Declined Events
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Create an Event

1. Click Calendar. 

2. Click New Event.

3. Enter an event name in New Event field.

4. Set date and time for the event.

5. Set a frequency to the event repeat itself. 
I.E. Every week.

6. Set a location for the event.

7. Set a notification to alert you that the 
event is coming up. Default time set is 15 
minutes prior to the event start time. 

8. Click Scheduling Assistant to change this 
to a meeting.

9. Add required invitee. Enter the invitee’s 
name and select the invitee from the list 
of contacts. Repeat for all invitees.

10. Find a time and date that everyone is 
available and select it. 

11. Optionally, Add a location.

12. Select Done.

13. For a Teams meeting, enable Teams 
meeting.

14. Optionally, enter a description of the 
event.

15. Click Send.

Scheduling Assistant

Tinted area 
signifies the 
person is not 
available

Toolbar Options
① Event View - When creating an event, the default view is marked as busy, You can change the view for the following 

as Free, Tentative, Working Elsewhere or Out of Office. 

② Mark as Private - This will mark the event as private and anybody who has Access to your Calendar will see the event 
marked as private and cannot view the Details of the event.

③ Attendee Options - You may allow certain actions done by the attendee. You can enable/disable the ability to Request 
Responses, Allow New Time Proposals or Allow Forwarding. You can also Hide the attendees from seeing each other. 

④ Scheduling Assistant - Click to open the Scheduling Assistant 

⑤ Attach File - Attach a file that pertains to the event. You may attach any file including graphics or PDFs. 

⑤④③②①

3

8
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4
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5

6

11

7

14

9
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Accepting/Declining Invitations
In response to an invitation for a calendar event, the recipient has the option to accept, accept tentatively, decline, or 
propose a new time. By default, responding in any way sends a response to the organizer, but you have a choice of 
adding comments or withholding a response. When the invitation is accepted, it is automatically added.

1. When you open a meeting request, you will see a window very similar to an email message with additional buttons: 
Accept, Tentative, Decline and Propose New Time. You will also see a copy of your calendar on the right-side pane 
to let you know if you have any schedule conflicts. You don’t have to act on a meeting request right away; however, if 
you delete a meeting request, it will decline the meeting automatically.

2. Whether you Accept or Decline the request. There are additional options with your response:
• Respond With Comments: a new window will open for you to type in your comments in the message body. Click 

Send to send your response to the meeting organizer.
• Respond Without Comments: you will notify the meeting organizer that you are attending. The meeting request 

window will close immediately.
• Do Not Send a Response: if you select this, the meeting organizer won’t know if you are attending or not. The 

meeting request window will close immediately.
• When proposing a new time, you can choose Tentative and Propose New Time or Decline and Propose New Time.

3. After you respond to a meeting request, it will be moved from your Inbox to your Deleted Items folder.

Accept/Decline a Meeting Proposal
You’ve organized and sent a meeting request to a group of people. Someone replies back to you proposing a different time 
for the meeting.

Accept a new meeting proposal
1. In your email Inbox, open the meeting request.
2. Do one of the following:

• Click Accept Proposal.
• To view all new meeting time proposals, or to go directly to the calendar to see free and busy times of all requested 

attendees, click View All Proposals, and then update the meeting notice.
3. Click Send Update.

TIP: The people with the original invitation receive the updated meeting request.

Decline a new meeting proposal
When an invitee sends you a new meeting proposal and you don’t accept it, the invitee’s calendar shows a ‘tentative’ or 
‘declined’ status for that time frame. By not accepting their proposal, the meeting remains set for the original time.
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Share Your Calendar 
You can share your calendars in Outlook for Mac with family, friends, and co-workers. Permissions you can set range from 
co-owner to view-only, and you can take away their permissions to see your calendar at any time.

Share a Calendar with Someone

1. Go to the Outlook Menu and select Settings. 
2. Click Accounts.
3. Select an account and click Delegation and Sharing.
4. Click Add {+} (Fig. A). 

5. In the Search field, enter a name.
6. Select the account and click Add (Fig. B).
7. From the menu for Calendar. Select a role (Fig. C):

• Reviewer: can only read your calendar.
• Author: Can read your calendar and create events on your behalf.
• Editor: Can read your calendar, create events on your behalf and edit your events.

    NOTE: you may enable Delegates can see my private items to allow the delegate to see private items. 
8. Click OK

Fig. A

Fig. B Fig. C
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People
People is where your personal contacts are stored and where you can view any address books that have been set up 
for your organization. 

① New Contact Allows you to create a new contact.

② Accounts Click to navigate to different accounts in People. Click Expand (􀆊) to the left of the folder to expand or 
collapse a folder.

③ Toolbar The toolbar gives you quick access to frequent commands such as Add to Favorites, add a Category to a 
contact, edit a contact or even delete a contact. Click Options (�) to customize the toolbar for People. 

④ Show/Hide Task Pane Show or hides a mini calendar with your agenda for the day. 

⑤ Sort You can sort your list by any of the fields that you use. For example, you can sort it by Company instead  
of name.

⑥ People List A list of contacts for the selected account. Double-click on a contact to view more details. 

⑦ Quick Action tools Hover Next to a contact and it will bring up four quick actions. From left to right: 

• Call the contact
• Email the contact
• Send a message though Microsoft Teams
• Create an event with an invite to the contact

①

②

⑤

⑥

⑦

③ ④
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Create a Contact
1. Click New Contact.

2. Enter the person’s name and information that you have, such 
as job title, office, department, and company. Optionally, 
select a category for the contact.

3. Click Save when finished.

Tip:
To add a photo for the contact, drag a photo from anywhere on 
your computer onto the photo icon next to the contact’s name, 
or double click on the photo area and select the file that you 
would like to use.

Create a contact from an email message
1. Open an email message

2. Right-click on a contacts name or email address. 

3. From the menu, select Open Outlook contact (Fig. A).

4. Click Add to Contacts (Fig. B).

5. Enter additional Information such as company, phone number and address.

6. Click Save when finished.

Create a Contact Group
A contact group, also known as a distribution list, is a grouping of email addresses collected under one name. Messages 
sent to groups go to all recipients listed in those groups.

1. Hover over New Contact and select New Contact List (Fig. C).

2. Enter a name for the new contact list.

3. Enter an email address.

4. Click Add. 

5. After adding all the contacts you want into the contact group 
list, click Save.

6. Confirm the List appears in the Contact Lists. 

Fig. A Fig. B

Fig. C
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To Do
You can create tasks to keep track of the things in your To Do list. You can set start dates, due dates, and reminders for 
them. When you finish a task, you can mark it as complete by selecting the radio button next to the task. An overdue task 
appears in the Tasks list in red type. You can also set tasks to recur. When you mark an occurrence of a recurring task 
as complete, the next occurrence automatically appears on your list with a due date at the interval that you specified. 
Recurring tasks appear in the Tasks list with the recurrence icon. The Tasks list also displays e-mail and contacts that are 
flagged for follow up.

① Hide/Show Grouped Tasks List Click to hide/show grouped tasks.

② Smart Folder List List of pre-made Smart Folders. It includes: My Day, Important, Planned, Assigned to me, Flagged 
email and Tasks.

③ Group List Create your own group of tasks. 

④ Group Name The name of the folder your are viewing.  

⑤ Task List View View your tasks as a grid or as a list.

⑥ Sort and Group Sort your task by Importance, Due Date, Added to My Day, Alphabetically or Creation date. Click on 
Group and it can organize the list by Category . 

⑦ Add New Task Creates a new task. 

⑧ Task Details Modify a task or add more data to the task. 

⑨ Task Menu Right-click on a task to apply an action. 

Tips 
• Before going to the To Do Section, click on an account first, such as your Microsoft 365 Account. 

• Microsoft released a separate app called Microsoft To Do for iOS, iPadOS and macOS. The data from Outlook for 
Mac will sync with these separate apps.

• Click Share (       ) to share a task with a team member. You may send it as an email or copy the link and share it 
through A message service such as Microsoft Teams.

①

⑨

②

⑤ ⑥

⑦

⑧

③

④
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Create a task
1. Click in the field marked “Add a Task”. 

2. Enter a title for the task.

3. Click the calendar to set a due date. 

4. Click Add to save the task.

Edit a task
1. In the Tasks list, click the task that you want to edit. 

2. To The right of the list, the details of the task appears. You may:
A. Change the name of the task.
B. Add steps to the task.
C. Add it to My Day
D. Change the due date.
E. Set it to repeat of your choice of intervals. I.E. Monthly.

Move a task to a folder
1. Select a task. 

2. Right-click on the task and select Move task to.

3. Select one of the group list You have made. 

2

A

B

C

D

E

F

G

H
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F. Set a Category for the task.
G. Attach a file to the task.
H. Add a note.
I. Delete the task.

I
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Copilot
Copilot is an AI (Artificial Intelligence) interface that lets you search for specific information, generate text such as emails 
and summaries, and create images based on text prompts you write. Copilot in Outlook only supports work or school 
accounts, and Microsoft accounts. NOTE: Any Microsoft account using an account from a third-party email provider, 
such as a Gmail, Yahoo, or iCloud, can still use Outlook, but won’t have access to the Copilot features in Outlook.

Draft an email message with Copilot in Outlook
1. In Outlook, click New Mail.
2. To start a new message, click Copilot (     ) from the formatting bar.
3. Select Draft with Copilot from Copilot menu.
4. In the Copilot box, enter your prompt. For example, “Thanks for your help. I look forward to seeing you next week!”
5. When finished, click Generate. Copilot will draft a message for you.

5

4
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6. Review the message. If it’s not quite what you want, choose Regenerate draft and Copilot will create a new version. 

7. To change the tone and/or length of the output, select Options.:
• For Length, select Shorter or Longer.
• For Tone, select Direct, Formal, Casual, Make it a poem.

8. To start over, select Discard All, then select Generate again. 
9. When you’re satisfied, select Keep it.

10. Edit the draft as needed, and then select Send. 
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Email coaching with Copilot in Outlook
With Copilot in Outlook, you can get helpful suggestions on how to adjust the tone, clarity, and reader sentiment before you 
hit send. 

1. In Outlook, click New Mail.
2. Compose your email message.
3. Click Copilot (     ) from the formatting bar.
4. Choose Coaching by Copilot from the menu.

5. Copilot will review your email and offer suggestions on improving:
• The Tone (Fig. A & Fig. B)
• Clarity (Fig. C & Fig. D)
• Reader Sentiment (Fig. E & Fig. F)

Fig. A

Tone

Fig. B
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6. If you like any or all of the suggestions, incorporate the feedback into the draft.

7. When you are satisfied, send your email.

Clarity

Reader Sentiment

Fig. C

Fig. E

Fig. D

Fig. F


	The Outlook Main Window: Mail View
	Focused/Other Inbox
	Toolbar
	Message List Pane
	Email Message
	Flagged Email Messages
	New Mail Message
	Spell Check & Grammar
	Signatures
	Rules
	Search in Microsoft Outlook for Mac
	Profiles
	Automatic Replies
	Email Templates
	Categories
	Outlook Add-ins
	Junk Mail Protection
	Calendar
	Create an Event
	Accepting/Declining Invitations
	Share Your Calendar 
	People
	To Do
	Copilot

